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d MathType:: Tips to Makke Your Lifee Easier.
Welcomee to Equation Editor and
This sesssion is design
ned to help you
y get the most
m out of E
Equation Edditor and MatthType – thee
professio
onal version of the Equattion Editor in
ncluded in M
Microsoft Offfice. Ratherr than a compplete
tutorial or
o full trainin
ng session, we
w will use th
he allotted tiime to demoonstrate how to create
mathemaatical expressions with th
hese productts and how too best insertt them into M
Microsoft Woord
documen
nts, PowerPo
oint presentaations, and Web
W pages.
We will not
n use the “new”
“
Equa
ation Editor in Word 20 07 or Officee 2010. The ““old” one is still
availablee in all Officee 2007/2010
0 application
ns, and this iss the one wee’ll be using..
I hope many
m
of your needs will be
b addressed
d in this sessiion but if yoou need help in the futuree, the
following
g sources aree available:
9 MathType
M
Help
H
– Both Equation
E
Ed
ditor and MaathType havee extensive hhelp files. Inn fact,
th
he entire con
ntent of the MathType
M
User
U Manual is now incorrporated intoo MathType
Help.
H
9 What
W
else do
oes MathType work witth? – We haave additionaal help on ouur website foor
using MathTy
ype with maany other app
plications annd websites: www.desscii.com/interoop
9 Tips
T & Trick
ks – This is the
t newest feature
fe
of ourr website: M
MathType Tipps & Tricks.
Periodically we
w post new tips that hellp you get thhe best use oout of MathT
Type and savve
tiime in the prrocess: www
w.dessci.com
m/tips
9 Handouts
H
– Whenever
W
I present a sesssion like thhis one at a conference, I post my
handout on ou
ur web site for
f a year. You
Y can acce ss this handoout and otheers at
www.dessci.c
w
com/handou
uts
9 Technical
T
Su
upport – Wee provide life
fetime techniical support for MathTyppe. For technnical
su
upport:
¾ Phonee: 562-432-2
2920
¾ Emaill: support@
@dessci.com
¾ Web: www.dessci.com (click
k one of the S
Support linkks). A collecttion of “suppport
noticees” at the sitee covers mosst topics for both Equatiion Editor annd MathTypee.

Bob Mathews
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W
With Equation Editor open, these menuss are
Eq
quation Editor menus, not Word menuss.

1. Settting Fon
nt Styles
s in Equ
uation Ed
ditor
(see p. 6 for Ma
athType)

ont styles & sizes in Equ
uation Editorr is a
Setting fo
simple prrocess. Follo
ow these step
ps:
n Equation Editor.
E
1. Open
2. In thee Style menu
u, click Defiine.
3. Set th
he styles to the
t desired font
fo by using
g the
drop--down lists. The
T styles Text,
T
Functio
on,
Variaable, Matrix--Vector, and
d Number maay be set
to wh
hatever font you want. Normally
N
these 5
styless are the sam
me as each otther, and thee same
as wh
hat you’re ussing in Word
d.
CAU
UTION: Thesse 3 styles must
m always be
b set to Sym
mbol font: L
L.C. Greek, U
U.C. Greek, and
Symb
bol. Failure to
t do this wiill cause
unpreedictable ressults.

2. Settting Fon
nt Sizes in
Equ
uation Editor
E
Don’t
e
change
these
styles!

1. Open
n Equation Editor.
E
2. In thee Size menu,, click Defin
ne.
he Full size to
t the same size
s as your
3. Set th
text in Word. Usee “pt” to den
note points.
Sugg
gestion: Set the
t Full size in points,
and th
he other sizees in percentt. That way
when
n you changee the full sizee setting, you
u don’t needd to change tthe others. T
They will retaain
the prroper proporrtion. Use th
hese percentaage values ass a guide; revise as desirred:
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3. The MathType Toolbar (in Word)

The MathType toolbar contains 10 icons, or 11 if you’re using Windows 7 or Mac with Word 2011. The
descriptions below should help you decide when to use each of the icons.
Note: If you are using Office 2007 or 2010, these items are included in the MathType tab on Word’s
Ribbon. Some are also included on the Ribbon in PowerPoint 2007.
If you are using Office 2008 (Mac), there is one icon:
If you are using Office 2011 (Mac), there is both a toolbar similar to the one pictured above, as well as a
menu. Microsoft does not allow 3rd-party applications like MathType to modify the Ribbon in Office
2011, so we're unable to create a tab like we do on Windows.
If your toolbar looks like the one above, notice there are four Greek letter Sigmas. Each of these will open
MathType and allow you to insert an equation into your document. The difference between them is in the
placement of the equation and its relationship to the surrounding text.
– “Insert Inline Equation” – Inserts an equation inline with your text. An inline equation becomes part
of your paragraph, and moves with the text when you add or delete text. This is an example of an
2
2
2
inline equation: a + b = c .
– “Insert Display Equation” – Inserts an equation below the current line of text, like this one:

( x, y )

⎛ x + x2 y1 + y2 ⎞
,
=⎜ 1
⎟
2 ⎠
⎝ 2

When MathType inserts a display equation, it centers the equation on the line, and places the cursor
on the line below the equation, so that when you close MathType, you’re ready to continue typing.
and
– “Insert Numbered Display Equation” – Acts exactly like the previous icon, except places an
equation number either at the left or right margin, depending on which of the two icons you select.
Here is a “Right-Numbered Display Equation”:

y = 32 sin ( x −

2π
3

)+2

(4.1)

When inserting equation numbers, you can format them however you want – with or without
section or chapter numbers, with any kind of separator between the numbers (e.g., 1.1, 1-1, 1_1,
etc.), and with or without any kind of brackets you choose.
– “Toggle between TeX/LaTeX and MathType equations” (not available on the Mac) – This is a huge
shortcut if you know the TeX language. Even if you don’t know TeX, it’s pretty simple for many
things. For example, if you type $\sqrt2$ and click this icon, you’ll get 2 in your document
without opening MathType. Other shortcuts for the “Toggle TeX” button:
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\frac{numerator}{denominator} produces a fraction
\sqrt{radicand} gives a square root, and \sqrt{index}{radicand} gives an nth root
For Greek letters, type the backslash followed by the name of the letter.
\alpha = α , \omega = ω , \pi = π , etc.
Be sure to enclose the expression in $ signs, e.g., $\frac{\pi}{4}$
The next four icons on the MathType toolbar all have to do with equation numbers. Note that these are
not problem numbers, as in a test or quiz. They are equation numbers like you may see in a textbook or in
a journal article when the author needs to refer to a particular equation number in the text of the article.
There are very few times when a primary or secondary school math teacher would need to number
equations.
– “Insert Equation Number” – Inserts an equation number at the current position of the cursor. This
icon is most often used to add an equation number to a display equation that’s already in your
document.
– “Insert Equation Reference” – Inserts a reference in the text of the document, and links the
reference to a particular equation number. For example, I may say something like this: “In equation
(4.1) above, the number 2 indicates a vertical shift of 2 units up.” If I were to decide I needed a new
numbered equation above the current equation (4.1), the new equation would become (4.1), and the
current equation would be re-numbered (4.2). Since the reference I wrote above is linked to this
equation number, it also changes to (4.2).
– “Insert Chapter/Section Break” – Chapter and section numbers are not required when you’re
numbering your MathType equations, but if you do use them, you’ll need to change the chapter or
section number when you move to the next chapter or section.
– “Update Equation Numbers” – This icon isn’t needed very often, because when you add an
equation prior to an existing numbered equation, the equation numbers and references that follow
the new equation are automatically updated, as I described above. When you remove an equation
though, the numbers aren’t updated. (They may update when you save or print the document,
depending on how you have your Word options set up.) Selecting this icon will update the equation
numbers immediately.
The last icon on the MathType toolbar doesn’t have anything to do with inserting equations or equation
numbers; this icon affects the entire document.
– “Export to MathPage” – This will transform the entire Word document into a nice-looking web
page. For more information on exactly what happens when you click this icon, refer to the tutorial
Creating Webpages with Microsoft Word in the MathType 6 help file (Getting Started > More
Tutorials > Creating Webpages with Microsoft Word).
To the right of “Export to MathPage” is the “Browse by” window. You can choose to browse by
equations, equation numbers, or chapter/section breaks. This is similar to the way you can click an icon in
Word and go to the next page.
– Equation Browse – Clicking the right arrow will take you to either the
next equation in the document, and the left arrow will take you to the previous equation.
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4. Setting MathType Fonts & Sizes (the Style and Size menus)
You most likely want your equations to match the text in your document, PowerPoint presentation, or
web page, so you need to know how to change the fonts & font sizes in MathType.
The Style Menu – setting the fonts.
You’ll see several style names listed on the MathType Style menu,
but the one you’ll use most often is called “Math”. Actually, Math
isn’t a style of its own; it’s a combination of other styles.
MathType is smart enough, for example, to know that when you’re
typing sin ( π2 x ) , you probably want the variable and the lower-case
Greek letter to be italicized, but not the function name or the
number. Thus, MathType switches between Function, Variable,
Greek-Symbol, and Number styles as appropriate. (“Number” isn’t
a style you see on the menu, but it is a separate style of its own, as
we’ll see in a minute.) To set all this up, select “Define”, at the
bottom of the menu.
When you select Define, you’ll
see another “dialog box”. (A
“dialog box”, or simply “dialog”,
is a window like the one shown to
the right where you can select
options and settings.)
In the Define Styles dialog, you’ll
see a couple of “radio buttons”
labeled Simple and Advanced.
We’ll go over each of these.
“Simple” is the one you’ll use
most often.
In the selection labeled “Primary font”, the font you choose will be the font MathType will use for text,
function names, variables, vector and matrix names, and numbers. Normally you’ll want all of these to
be the same font, but we’ll see in a minute how to make them different. You’ll probably want the
Primary font to be the same font you’re using in your document. MathType doesn’t know what font
you’re using in your document, so it’s important to set it here.
The selection labeled “Greek and math fonts” isn’t normally changed. You’ll see you have only two
options there anyway – “Symbol and MT Extra” and “Euclid Symbol and Euclid Extra”. You likely
won’t see much difference between these two choices, so leave it set as you see above.
At the lower right of this dialog is a final checkbox, labeled “Use for new equations”. This is checked
by default, and if you leave it checked, all subsequent equations you create will use these same font
settings until you change them again. If you’re just wanting the next equation to have a certain special
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look, but want the rest of the equations to look like the equations before the one you’re working on,
uncheck this box.
After everything’s set the way you want it, click OK and the dialog closes.
Now click on Style/Define again,
and this time select Advanced.
You’ll see the dialog that’s
pictured to the right. This is where
you would make special settings,
like if you wanted all the numbers
in Arial and the rest of the
equation in Times New Roman,
for some reason. Notice also the
boxes labeled Bold and Italic.
Check or uncheck as desired. (By
the way, “L.C. Greek” is lowercase Greek. Guess what “U.C.
Greek” is?)
User 1 and User 2 styles are not
normally used, but when you need
them, they’re quite handy. One
example where you may want to
use a “User” style is if you’re
discussing the effect of a
variable’s coefficient on a graph (or you want the student to do so), so you choose to have the variables
in Times New Roman italic, but the coefficient in Times New Roman bold italic. For example, I could
say, “Describe the effect on the graph of the function when the value of a increases: y = ax 2 + bx + c .”
In this example, I used User 2 style for the coefficient a.
The Size Menu – setting the sizes.
Just like MathType automatically changes the style depending on the types of items contained in your
equation, it also changes sizes. For most of your equations, you’ll just leave the size specification set to
“Full”. When you type an exponent, MathType knows you want it to be smaller than the base, so it
switches to “Subscript” size. Likewise, if you’re teaching sequences
and series, and want to enter a summation template, MathType knows
to create the Sigma symbol larger than the surrounding variables and
numbers, so it switches to “Symbol” size. Even though this switching
is automatic, you still have control over what sizes MathType uses
when it selects these special sizes. To specify these sizes, select
“Define” at the bottom of the Size menu.
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The “Define Sizes”
dialog is quite
different from the
Define Styles dialog.
One of the major
differences is the
presence of a
“preview window”.
The preview window
doesn’t show you
the actual equation
you may be working
on, but it does give you an indication of what exactly will change if you change the setting that’s
highlighted to the left of the preview window. For example, in the picture above, the only thing that
will change in that sample equation when I change the “Full” size setting (notice the “12” is
highlighted) is the X.
In MathType, the size setting called “Full” is the setting that you want to be identical to the text size in
your document. If you’re typing a test, and you’re using 11-pt type size, make sure the MathType
“Full” size is set to 11-pt.
Notice the rest of the sizes (except “Smaller/Larger Increment”) are specified as a percent. Percent of
what? These are percentages of the “Full” size. The beauty of leaving these set as percentages is that
once you set them, you never have to change them! If you change the Full size from 10-pt (like you
may use in a quiz) to 32-pt (like you may use in PowerPoint or on an overhead transparency), you
don’t have to change the other sizes because they’re still proportionally correct. If you want to set these
other sizes as point sizes, you have that option, but chances are you won’t want to. (Notice there’s a
User 1 and User 2 size. Use these similarly to the way you’d use a User 1 or User 2 style.)
So, what’s a “Smaller/Larger Increment”? Notice back up on the MathType Size menu (pictured at the
bottom of the previous page), two items near the bottom are labeled “Smaller” and “Larger”. If you
want to make an item or items in your equation smaller or larger than the surrounding items in the
equation, you can select them, and repeatedly select Smaller or Larger from the Size menu until you
get the size you want. How much smaller or larger MathType makes them is determined by the
“Smaller/Larger Increment” on the Define Sizes dialog.
BEWARE – It’s generally not a good idea to highlight an entire equation and select Smaller or Larger,
because the results will almost certainly not be what you wanted! (see below) If you want to increase
or decrease the size of an entire equation, the best way to do it is by changing the Full size
specification. You may want to deselect the “Use for new equations” checkbox.
Example: 10-pt: x 2 ; 18-pt:

x 2 ; 10-pt plus 8 “larger” applications: x2

Notice that the 18-pt expression is proportionally correct, but the 10-pt equation that was converted to
18-pt by repetitively clicking “larger” on the size menu has an exponent that is too large. That’s
because both the base and the exponent are increased by 1-pt each time you click on “larger”.
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5. MathT
Type Pre
eference
e Files
t match the text of yourr document, but you probably don’t always
You naturallly want yourr equations to
use the samee font or sam
me size font. MathType gives
g
you a cconvenient w
way to changge between ffonts &
sizes by letting you savee these settin
ngs into a “preference fille”. Let’s sayy you want tto create youur 7th
Grade Math
h tests in 12-p
pt Times Neew Roman fo
ont, but you want to use 10-pt Arial for your 8th Grade
Pre-AP Algebra tests.
The
T first thin
ng to do is to save “12-ptt Times New
w Roman” ass a
“Preference
“
File”.
F
Those are the defaault settings when you innstall
MathType,
M
so
o chances arre, that’s what’s set now. To save it, click
on
o Preferencees in the MaathType mennu bar. Now point to Equuation
Preferences,
P
and another menu expannds. In this m
menu, click oon
“Save
“
to Filee…” In the nnext dialog, yyou’ll get a cchance to naame the
preference
p
fille. Since it’ss only a file llike any otheer file, you ccan
nname it like aany other filee.
N
Notice how tthe others aree named
thhough. Theyy are named with the
nname and sizze of the fontt. That’s
a good idea, bbecause it heelps you
kknow what too expect wheen you
select that paarticular prefference
fi
file. After you type in a ffile
nname, click S
Save.
Now that wee have a preference file saved for 12
2-pt Times N
New Roman, change youur style to Arrial.
(Remember, you do thiss in the Stylee menu by seelecting the D
Define optioon at the botttom of the m
menu.
Also recall that
t it’s easieer if you seleect the “Sim
mple” option..) Now change the “Full”” size settingg to 10.
(This is in th
he Size menu
u, under Deffine.) Don’t change any of the otherr sizes. Now save the preeference
file and nam
me it “Arial-1
10”, or anoth
her name of your choosi ng. (You doon’t need to ttype in “eqp” after
the file nam
me; MathType will add th
hat for you after you clicck Save.)
So, what’s saved
s
in a prreference fille? We’ve allready seen ttwo of the thhree categoriies of data thhat are
saved in a preference fille, but there is one more – spacing. L
Let’s say youu’re lookingg at your
superscripteed numbers and
a variabless, and you th
hink the expoonent needs to be a littlee closer to thhe base,
and the num
merator in yo
our fractions is a little too
o close to thee fraction baar. By explorring the mennus, you
stumble acro
oss somethin
ng in the Forrmat menu laabeled “Defi
fine Spacing””. In this meenu, you disccover
how to chan
nge your sup
perscripts and
d fractions to
o look more like the exaamples below
w:
to
You chan
nge x 2 ⎯⎯
→ x2 and

2
2 to
⎯⎯
→
.
2
2

Any adjustm
ments you make
m
in the Define
D
Spacin
ng dialog aree also saved to the preferrence file.
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6. Creating a blank grid for student graphing
One of the most common questions we get is “Does MathType make graphs?” I always give a
“qualified” answer to that question – No, MathType won’t graph a function, but you can make a blank
grid for students to do the graphing. Note: There is a more detailed procedure for grids and number
lines on our web site. You can access this tip at
http://www.dessci.com/grids
(This will be done using Equation Editor. If you are using MathType, the steps are similar.)
a. In a Microsoft Word (the procedure may be adapted for other software), open Equation
Editor From the Insert menu, and select Object. From the list, choose “Microsoft
Equation”, and click OK.
b. On the Matrix templates palette, select Variable-size matrix or table.

You can look at the “Status Bar” – the very bottom of the Word or MathType window – to see
what it is you’re pointing to:
c. In the Matrix dialog, specify the size you want. You probably want
a larger one than 6×6, but we’ll use this size as an example. The
maximum size is 30×30, so if your axes will be in the center, that’s
±15 on both axes. Notice the comment at the bottom of the dialog:
“Click between elements to add/change partition lines.”
d. There are 4 types of lines: no line (the default), solid line, dashed
line, and dotted line. You select the type of line by continuing to
click in the same location (twice for dashed, etc.). If you put solid
axes in the center of the
grid, and dotted lines
everywhere else, the screenshot to the left is what the
dialog would look like when you’re through. Below is
what the grid looks like in your finished test, quiz, or
whatever (these are dotted lines except the axes).
In MathType, the column and
row specifications are in a
different place, and there is a
“Clear all lines” button, which is
handy. You can also save the
grid on the MathType toolbar,
which you can’t do in Equation
Editor.
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7. Changing Wo
ord defa
aults for menus & drawings (W
Windows))
A couple off aggravating
g features off Word 2002 and later (i.e., Office XP
P and later) are related tto the
us and creatin
ng drawings with the draawing toolbaar.
Word menu
1. The defaault is for Word’s
W
menuss (pre-Word 2007) to shoow only
basic commands afteer you first install
i
Officee. As you woork, the
menus adjust
a
to show
w only the ittems you’vee used most rrecently. If
you waitt a couple off seconds, th
he full menu appears. If yyou don’t
want to wait, you caan click the double
d
chevrron at the boottom of
the menu
u.
2. To chan
nge this behaavior to alwaays show the full menus, click on
Tools > Customize.. On the
t box nextt
Optionss tab, check the
to “Always show fulll menus”.
3. The defaault for using
g the
“AutoSh
hapes” on the Drawing
toolbar is
i for Word to
t create a
“Drawin
ng Canvas”, into which
you’ll in
nsert your drrawings. If
you don
n’t want the Drawing
D
Canvas, you can chaange the
default.
4. Except for
f Word 20
007/2010,
click on Tools > Op
ptions, and click
c
on the General
G
tab . Near the boottom of thee tab, unchecck the
box labeeled “Autom
matically creaate drawing canvas
c
whenn inserting A
AutoShapes””.
5. For Worrd 2007/201
10, click on the
t Office Bu
utton if in W
Word 2007, oor the File taab if in Wordd 2010,
then clicck Word Opttions. Click on Advanceed, and the 5tth option from
m the top is “Automaticcally
create drrawing canv
vas when inseerting AutoS
Shapes”. Unncheck this an
and click OK
K.
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8. Nudging and the MathType Customizable Toolbars
Nudging is a technique that can be accomplished in both Equation Editor and MathType, and is
very useful in achieving perfect positioning for your equations.
1. For example, let’s say you’d like more space between an integral symbol and the limits of
integration. We’ll add more space by nudging the limits to the right.
2. Select the upper limit. The most common method to select items is to drag the mouse across the
item. For small items though, such as limits, subscripts, etc., it’s easier to use the Shift and arrow
keys. With the cursor to either the left or right of the item you want to select, hold down the Shift
key as you press the either the left or right arrow key, as appropriate. Release the Shift key after
you’ve completed the selection.
3. Hold down the Ctrl key. Use the arrows on the keyboard to move the selected item(s) in the desired
direction.
∞

∞

∫ f (x )dx

∫ f (x )dx

before nudging

after nudging

0

0

Note that not all printers will print the limits as tightly-spaced as the ones in the “before” example.
You may have to experiment with nudging a bit in order to find the proper amount.
If you’re using MathType, you can save the newly-nudged expression or equation to the toolbar. That
way you don’t have to nudge it every time you use it:

If you want a more generic situation than what’s shown above (you won’t always want limits of zero to
infinity), see “Saving to the MathType toolbar” on page 17 of this handout for a hint about how to do
that.
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9. Aligning items within an equation
There are all sorts of things to align within an equation – the subtraction shown beneath a dividend in a
long division problem, equations in a system of equations, items in a pictogram, responses in a
multiple-choice question, etc. We will look at two of these: systems and multiple-choice. Note: Even if
you don’t teach the level of math requiring systems of equations, and even if you never create multiplechoice tests, the techniques learned here will still be useful to you.

9a. Systems of equations and inequalities
a. There is no right or wrong way to “align” the equations in a system; it’s basically a matter of
choice, and a matter of what your students can read the best. (For simplicity, we won’t specifically
mention systems of inequalities, but these exact steps will work for those as well.) Here are 4
different scenarios:

⎧5x − 3 y = 6
⎨
⎩2 x + 7 y = 2

⎧ 3x + 4 y + z = 17
⎪
⎨2 x + 3 y + 2 z = 15
⎪ x+ y+ = 4
⎩

=3
⎧ x
⎪
=3
⎨2 x + y
⎪ 3x + 2 y + z = 3
⎩

⎧x = 3
⎪
⎨2 x + y = 3
⎪3x + 2 y + z = 3
⎩

1

2

3

4

b. Systems 2 and 3 above present the greatest challenge, so let’s deal with system 2.
c. In this system, we want to align the variables, the operation symbols (+, −, or =), and the sums so
that they are vertically aligned with similar elements in the previous equation, and right-justified
within each column (for example, z & 2z and 15 & 4 in system 2 above).
d. There are many ways to align a system, but let’s just cut to the chase and say that using a matrix is
the best way to do it. So with that established, what size? The obvious number of rows is a number
equal to the number of equations. There are several choices for the number of columns, but the best
balance between utility and ease of use is a number of columns equal to the number of equations
plus one. So our matrix for system 2 above will be a 3×4.
e. The first step is to insert the Left brace from the Fences palette on the Equation Editor or
MathType toolbar. The icon you’re looking for on the Fences palette is this one:
. (It’s in
column 1, 4th from the bottom.)
f. Next insert a 3×4 matrix by selecting “Variable-size matrix” from the Matrix templates palette,
making sure to select Column align: Right in the Matrix dialog.
g. Now you’re ready to insert the equations into the matrix, but how you do it is critical! Enter 3x + in
the first cell, press Tab to go to the next cell, enter 4y +, press Tab, enter z =, press Tab, and enter
17 in the last cell. Pressing Tab once more gets you down to the
next
3x + 4 y +
z = 17
⎧
row to begin entering the second equation. Enter the next 2
⎪
equations similarly. This is how it should look when you’re done ⎨2 x + 3 y + 2 z = 15
⎪ x+
y+
= 4
⎩
So, how do you get the right amount of space where the “+” should be? In Equation Editor,
your only choice is to add spaces. Problem is, 3 isn’t enough and 4 is too many. In MathType,
there’s a more elegant (and more exact) way: insert a +, then color it white !
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(doesn’tt look very pretty,
p
does it?):
h. One morre step, then
n we’re done. There’s a simple
s
adjustment that leets us move the columnss of the
matrix closer
c
together. On the Format menu
u, select Deffine Spacing
g. The third item from th
he top is
what you
u want to ad
djust: Matrix column sp
pacing. The normal settiing is 100%. Since we w
want to
decreasee the spacing
g, we want a number smaaller than 1000%. (If the dialog is in tthe way andd you
can’t seee your equattions, place the
t mouse po
ointer on thee title bar of the Spacing
g dialog and
d drag it
away fro
om your mattrix so that you
y can see your
y
entire s ystem.) Try a spacing vaalue of 50%, but
don’t cliick OK yet. Watch
W
your system of eq
quations as yyou click Ap
pply. If you like the resu
ults,
click OK
K; if you neeed to decreasse the spacin
ng further, tryy a smaller nnumber. (It’ss easy to seee how
valuablee the Apply button
b
is. It’s a real timee saver whenn compared tto repetitivelly clicking O
OK each
time, because once you
y click OK
K the dialog disappears. Also, it’s im
mportant thatt the percentt symbol
is selected in the dro
op-down box
x. You don’tt want a spaccing of 50 pooints or 50 innches!)
ou settle on a value (my personal
p
opiinion is that 25% looks bbest), either click in yourr
i. After yo
documen
nt to close th
he Equation Editor wind
dow and go bback to Wordd, or if you’rre using MatthType,
simply close
c
the MaathType wind
dow (click th
he × in the uupper right-hhand corner, or the “stopplight” if
you’re using
u
a Mac)).
jj. In Math
hType, you have
h
two attrractive optio
ons you don’ t have in Eqquation Editoor:
¾ You can save thee matrix spaacing to a preeference file. This is a goood idea, because you w
won’t
wantt to use this tight matrix column spacing in a “reegular” matrix, and this w
will give youu an
easy
y way to chan
nge back to your
y
“system
ms of equatioons” settingss. A MathTyype preferennce file
hold
ds informatio
on on fonts, sizes,
s
and sp
pacing. To saave the prefeerence file, ggo to the
Prefferences meenu, scroll do
own to Equa
ation Preferrences, then
n choose Sav
ve to File. Y
You can
name the file any
ything you want,
w
but herre are some ssuggestions:: Systems (if you alwayys use
the same
s
font an
nd size for yo
our tests & quizzes);
q
Sys
stems-TNR, Systems-A
A, etc. (for teests
writtten in Timess New Romaan, Arial, etcc. font); Systtems-A-10, Systems-A
A-12, etc. (forr tests
writtten in Arial 10pt, Arial 12pt,
1
etc.). You
Y get the ppicture.
¾ You can save a blank
b
templaate for a 2-eq
quation systeem, one for a 3-equationn system, etcc. to
yourr MathType toolbar. Thee easiest way
y to do this iss to delete evverything ouut of the cellls of the
matrrix in the sysstem you just created, theen highlightt everything and drag it uup to the tooolbar:
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9b. Multiple-choice responses
a. There are many ways to type multiple choice responses for a test or quiz. You may create each
choice as a separate equation (remember, we use the word “equation” to denote anything created
with Equation Editor or MathType, regardless of whether or not it contains an equals symbol), or
you could include all the responses in a single equation and arrange them in various ways. Two
common ways to arrange the responses are to place them all on the same line of text or to put two
responses on one line and two on another line. We’ll deal with the first option here.
b. For this example, we’ll create the responses for this question:
1. Find the quotient: 1 32 ÷ 1 21

a. 2 35

b. 2 21

c. 1 91

d. 2

c. One option would be to type the question and all the responses as a single equation, but we’ll type
the question text in Word and the division expression and responses in Equation Editor or
MathType. We’ll type all 4 responses as one object.
d. Assuming you’ve already typed the question, let’s work on the responses. Open Equation Editor as
you normally would, either from the Insert menu or by clicking the icon on your Word toolbar.
(This will be specifically Equation Editor. These steps will work, of course, in MathType as well,
but there will be separate steps for MathType later.)
e. We’re using Arial font and 11pt size, so adjust your Style and Size accordingly. If you don’t
remember how to do that, see page 3 of this handout.
f. We want to space the responses uniformly, and the best way to do that is to use a matrix. This will
be a 1-row, 4-column matrix, so go ahead and insert one of those in your document.
g. Change to Text style, then type the letter a followed by a period and a space.
(Notice the space bar works just fine in Text style.) Change to Math style, then
type 2 35 . When you type the fraction, be sure to use the Reduced-size vertical
fraction, which is the one in the upper-right of the Fraction and radical
templates palette.
h. An easy way to keep from switching from Text to Math four times is to copy what you just typed
(i.e., select the contents of the first cell with your mouse, then press Ctrl+C or Cmd+C to copy).
Now press Tab to go to the next cell, and paste the contents into that cell (Ctrl+V or Cmd+C is the
shortcut). Do the same with the remaining 2 cells, then edit the contents so that it looks similar to
the above example. We’ll adjust the spacing in the next step.
i. Since this is a matrix, and you already know how to adjust the column spacing in a matrix, go
ahead and adjust it to see what looks best. (I think somewhere in the range of 300-400% looks best,
but that’s just my opinion. Use whatever setting you like.)
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j. In MathType, you have another tool that makes it even easier to create multiple-choice responses,
and easier to keep the spacing uniform from one question to the other. If you’re using MathType,
click on the View menu and make sure there’s a checkmark by Ruler.
k. Notice above the ruler there are 5 arrows. These arrows represent 5 types of tabs that are available
in MathType. From left to right, these are:
1) Left-justified tab. This is the one selected in the screenshot below, and is the default. When you
use a left-justified tab, the left edge of the text will be aligned at the tab.
2) Center-justified tab. The center of the text is aligned at the tab stop.
3) Right-justified tab. The right edge of the text is aligned at the tab stop.
4) Relational tab. Use this tab only with more than one line of characters within your equation.
This will align equations or inequalities at any relational operator, such as ≠, ≥, ≡ , ∝ , and of
course =. (Basically, it will align on the equals, greater than, or less than signs from the
keyboard, plus anything on the Relational symbols palette.)
5) Decimal tab. Use this one also for more than one line of characters. This is for aligning a
column of numbers, regardless of whether or not a decimal point is present.

l. To set a tab stop, simply select the type of tab you want to use and click on the ruler below the
number or tick-mark where you want the tab to be. Caution: Each template slot has its own set of
tabs, so if you are inside a numerator slot (for example), and set a tab at the 1” mark, that tab will
not be set outside the fraction! In the example above, make sure your “insertion point” (i.e., cursor)
is outside the fraction before you set the tab. You won’t run into this problem if you set your tabs
prior to typing the MathType equation, but you won’t always know where you want the tabs set
before you start typing. Just be aware of this feature of tabs.
m. For our example, since we’re using tabs to align the multiple-choice responses, we don’t need our
1×4 matrix. You can use the matrix if you want, of course, but you wouldn’t use both a matrix and
tabs.
n. One final point on tabs. You already know what the Tab key’s for when you’re typing in
MathType; it’s to move from one template slot to another, or to move out of the template. To move
to the next tab stop, you need to press the Ctrl+Tab keystroke combination.
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Saving to th
he MathTypee toolbar:
Naturally yo
ou don’t wan
nt to have to go through the process of creating tthis for eachh question. Y
You
could copy the
t responsees from one question
q
and
d paste them
m into anotherr, then edit tthe responses, but
there’s an eaasier way. Using
U
the exaample above, delete eachh response annd in its placce, insert a 11x1
matrix. With
hout the mattrix, the insertion point (i.e.,
(
cursor) will appear after the “d.”, then to tyype the
“a” responsee, you’d hav
ve to click th
he mouse in that
t positionn. Having thee 1x1 matrixx in place beffore you
save it to thee toolbar giv
ves the inserttion point a place
p
to landd when you click on the item to use it next
time. See grraphic below
w:

The 1x1 maatrix is also handy
h
for oth
her purposess, such as thee generic quaadratic form
mula and the generic
nd
2 degree polynomial
p
you
y see on th
he Algebra to
oolbar abovee. (The greenn rectangles in the toolbar
expressions are just emp
pty template slots.) It’s a good idea tto save the 11x1 matrix too the toolbarr for
easy access in future situ
uations such
h as this. You
u see it savedd above on tthe small Algebra toolbaar.
The 1x1 maatrix is also useful,
u
but no
ot really neeeded, for situuations wherre you want tto retain som
mething
you’ve nudg
ged, but you want to rem
move the con
ntents from thhe template slot. Take foor example tthe
definite inteegral we saw
w earlier in th
he handout. If
I you save tthe integral w
with nudgedd limits to thee
toolbar but delete
d
the lim
mits first, thee nudging is removed. T
The 1x1 matrrix would woork in this siituation,
but a better way to do it is to insert an
a integral symbol with empty limits & integrannd. Double-cclicking
s
the lim
mit slot itselff, allowing you
y to nudgee it. Nudge thhem both, thhen select thee
a limit will select
integral and
d drag to the toolbar.
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10. Using Word’s AutoCorrect Feature
Some things you create with Equation Editor or MathType are repetitive – the grid discussed earlier,
for example. If you’re creating a worksheet on graphing linear functions, you’ll quite likely have 10 or
20 of these, so it’s very useful to be able to insert a grid with just a few keystrokes – and without even
opening up MathType!
Note: There is a more detailed tip on our web site for using Word’s AutoCorrect and AutoText
features. You can access this tip at
www.dessci.com/autocorrect
(This will be done using Equation Editor. If you are using MathType, the steps are similar. Since many
of the things we’ve done in this session has been done with Equation Editor, you may wonder what’s
so much better about MathType? There’s a page later in the handout that discusses this.)

Setting up AutoCorrect to Insert Equation Objects

a. For the purpose of this mini-tutorial, we’ll
use the grid created earlier. Insert the 6-by-6
grid into your document:

b. If it doesn’t appear to be perfectly square,
you can make it square by clicking on it with
your right mouse button (Mac, Ctrl+click),
then selecting Format Object from the
menu. If Format Object doesn’t appear on
the right-click menu, select Object from
Word’s Format menu. (In Word 2007, if
Format Object isn’t be in the right-click
menu, click on the Drawing Tools > Format
tab in the Ribbon, then adjust the size in the
Size group.)
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c. Adjust th
he height an
nd width to th
he same
number – whatever you
y want theem to be.
Make su
ure the Lock
k aspect rattio box is
uncheck
ked!

d. Regardleess of wheth
her you re-sizzed your grid
or not, make
m
sure it’s still selected (as the
one is to
o the right). If
I it’s not sellected, click
once on it with yourr left mouse button.
b

e. With thee grid selecteed, choose AutoCorrect
A
t
Options
s from Word
d’s Tools meenu. If you’rre
using a version
v
of Word
W
earlier than Word
2002 – the
t one that comes
c
with Office XP –
it will ju
ust say AutoCorrect. If you’re
y
using
g
Word 20
007, click the Office Button, then
click Wo
ord Options
s. Click Proo
ofing on thee
left, and
d the AutoCo
orrect Optio
ons button
will appear on the riight.
f. Note thee grid is alreaady in the bo
ox
underneath the word
d With:. If it’s not there,
u didn’t havee it selected in step d
then you
above. Go
G back and repeat stepss d & e. (You
u
must do it this way; you can’t co
opy the grid
and pastte it into the box.)
g. In the Replace box,, type in whaatever code you
y want to enter in Word to be repllaced with thhe grid.
More on
n this later, but
b I chose a shortcut I co
ould remembber: “gr” forr “grid”, “6”” meaning “66-by-6”,
and “a”, meaning it has axes.
h. Click Ad
dd, then clicck OK.
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i. Now that you’re back in your document, delete the grid and try your AutoCorrect entry. Type gr6a
(or whatever code you entered), followed by the spacebar. Your code should be replaced with a
grid.
Here are some notes about what we just did:
1. I had you hit the spacebar after the code, but there’s nothing magical about the spacebar. The
important thing is that you tell Word that you’re through typing that word, and in this case, our
word was gr6a. Think about what normally “terminates” a word – a space character, any
punctuation character, a Tab, a new line, or even a mathematical operator (such as < or =). In fact,
any of these things will replace your code with your grid (or whatever you entered into the
AutoCorrect box).
2. The code I chose – gr6a – may seem a little cryptic to you, and you may not think you can
remember that one. That’s fine; choose whatever code you’ll remember, but be careful! You don’t
want to choose a word that will likely appear in any document. The words “grid” or “graph”, for
example, appear often, so you don’t want to choose these. I’m 100% sure the code I chose will
never come up in any document ever – unless I want a 6-by-6 grid.
3. What other uses for AutoCorrect can you think of ? I can think of several:

sq2 for 2

2p/3 for

2π
3

1/8 for 18 , etc.
limx0 for lim

x→0

u238 for

238
92 U

−b ± b 2 − 4ac
qu or qform for
2a
⎡1 0 0 ⎤
imat3 or simply i3 for ⎢⎢0 1 0⎥⎥
⎢⎣0 0 1 ⎥⎦
gr-th for θ , etc.

xb or xbar for x
…and so on.
4. You can use AutoCorrect for even more complex objects than the ones we’ve used, but that’s
really a subject to deal with elsewhere – like in the Tip I mentioned earlier that’s available on our
web site!
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11. Template Re
eplacem
ment
Sometimes you
y may finiish typing an
n expression
n, then decid
de it would loook better w
with a differeent
template. Here
H
are a cou
uple of exam
mples:
1. You’re working
w
with
h quadratic equations,
e
an
nd type thiss equation:

y=

1 2 3
2
x + x+
2
2
3

You reallize the equa
ation would look better with
w
smallerr fractions. R
Rather than re-type it alll, you
should use
u templatte replacem
ment. Here arre the steps for templatee replacement:

fr
a. Select the first fraction:

.

own the Ctrll key on the keyboard (u
use the Alt k
key for
b. Whille holding do
Equa
ation Editorr or on the Mac
M for eitherr Equation E
Editor or Ma
athType),
selecct the Reduced-size fra
action temp
plate from th
he Fraction
n and
radiical templa
ates palette, as shown to
o the right.
c. Repe
eat for the re
emaining 2 fractions.
f

y = 12 x 2 + 32 x + 32
ate an integrral, and reallize you shou
uld have speecified an exp
panding inteegral:
2. You crea

1

∫ 1 + x 2 dx = tan

−1

x+c

You rem
member read
ding somewh
here that if you hold dow
wn the Shift key while you select an
integral template, itt creates an expanding integral sym
mbol. (This w
works in Equa
ation Editorr as
well.) Yo
ou also reme
ember that holding
h
down
n the Ctrl keey (Alt key iin situationss listed above)
allows you
y to replace one templa
ate with ano
other.

Holding down both the
t Ctrl and
d Shift keyss lets you rep
place the inttegral with a
an expanding
g
integral.
NOTE: For template re
eplacement, it’s
i importan
nt to select tthe entire template, but only the tem
mplate
(and the tem
mplate conte
ents) you wissh to replace
e. See screen
n shot. Notice that only tthe integral and its
corresponding integrand
d are selecte
ed.

page 21

12. Keyboard Shortcuts
S
s
The keyboard shortcuts builtt-in to MathTyp
pe are listed in
n the Help file. You’ll find, thhat most of the shortcuts are sso
intuitive that you
y can learn th
hem quickly th
hough, and be able
a to use the software even more efficienttly to create
professional-lo
ooking documeents.
Many of the sh
hortcuts used in
n MathType arre “standard” shortcuts
s
– suchh as CTRL+S foor save, CTRL+C for copy, CTR
RL+V for
paste, etc. (On
n the Mac, mosst of the time yo
ou can substitu
ute the COMMA
AND key for the
e Windows CTRL key.) Listedd here are
some of the most
m commonly-used keyboard
d shortcuts:
Text modee ...................................................... SHIFT+CTTRL+E
Math modee ..................................................... SHIFT+CTTRL+=
Greek letteers ................................................... CTRL+G, followed by ccorresponding
....................................................................... letter of the alphabet (aa for α, etc.)
Expanding
g” parentheses................................. CTRL+9
Full-sized fraction templaate ........................... CTRL+F
Radical (sq
quare root)...................................... CTRL+R
Superscrip
pt (exponent) ................................... CTRL+H (“h” for “highh”; COMMAND+E on the Mac)
Subscript ........................................................ CTRL+L (“ ” for “low
w”)
Thin spacee ...................................................... CTRL+SPPACE
Insert equaation in Word ................................. CTRL+ALLT+Q
Edit equatiion in Word .................................... ALT+O ((select the equaation first)
board shortcutss, you can referr to
For more keyb
• “Customize
“
Keeyboard” in thee MathType Preferences menu
nu
• The
T MathType Help file undeer “MathType Reference/Key
R
yboard Shortcuuts.”
• The
T Equation Editor
E
Help filee: “Reference Information/Ke
I
eyboard Guidee.”
Also note that in MathType, when you poin
nt to an item with
w the mouse,, the descriptioon and keyboarrd shortcut are displayed
in the Status Bar:
B

MathTType displaays descrip
ption and
keybo
oard shortccut informaation in
the staatus bar. EEquation Ed
ditor
displays only thee description.
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13. Making Changes to a Matrix
Sometimes you may wish to modify an existing matrix. This may happen for any one of several
reasons – you need to change the matrix dimensions, you need to change the column alignment, you
need to add or remove partition lines, etc. We’ll first look at changing a matrix in Equation Editor, then
see the additional matrix features in MathType.
Example 1. You have this problem on a test:
⎡7 5⎤ ⎡ 1 2⎤
4. Add the matrices: ⎢
⎥+⎢
⎥=?
⎣3 1⎦ ⎣3 4⎦

You’d like to make problem #5 a matrix multiplication problem, a 3x2 matrix multiplied by a 2x3
matrix. You decide to use the matrices from problem #4, and adjust the dimensions. Here’s what you
need to do:
1. Copy the matrices from problem #4 and paste them into problem #5:
⎡7 5⎤ ⎡ 1 2⎤
5. Multiply the matrices: ⎢
⎥+⎢
⎥=?
⎣3 1⎦ ⎣3 4⎦

2. Now let’s change from addition to multiplication, and add a new row 3 to matrix 1 and a new
column 3 to matrix 2.
a. Double-click the matrices to open the problem in Equation Editor:

b. Click inside matrix 1 so that the insertion point is flashing inside one of the matrix cells:

Correct

Incorrect!

c. In the Format menu, click on Matrix:
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d. Change the matrix dimensions to 2 columns and 3 rows. Similarly, change the dimensions of
matrix 2 to 3 columns and 2 rows. Insert the contents of the empty cells. Question 5 now looks
like this:
⎡7 5 ⎤
⎢
⎥ ⎡1 2 5⎤
5. Multiply the matrices: ⎢3 1⎥ ⎢
⎥=?
3 4 6⎦
⎣
⎢⎣2 4⎥⎦

3. Re-dimensioning a matrix in this way will always result in new columns being added to the right
and new rows added to the bottom. Making a matrix smaller will remove columns and rows from
the right and bottom, respectively. This is the only way to re-dimension a matrix in Equation
Editor. MathType gives you more utility by allowing you to add or remove a row or a column
anywhere in the matrix:

Example 2. You need to add a partition line to a 3x4 matrix to make it an augmented matrix:
⎧ x − 2 y + 2z = 9
⎪
⎨ − x + 3 y + = −4
⎪ 2 x − 5 y + z = 10
⎩

⇒

⎡ 1 −2 2 9 ⎤
⎢ −1 3 0 −4 ⎥
⎢
⎥
⎢⎣ 2 −5 1 10 ⎥⎦

1. With your cursor inside one of the cells in the matrix, click on Format > Matrix. (If using
MathType, click on Format > Matrix > Change Matrix.)
2. Click once between rows 3 & 4 for a solid line, twice for a dashed line, or
three times for a dotted line: (Hint: use decimal alignment in the matrix.)
⎡ 1 −2 2 9 ⎤
⎢ −1 3 0 −4 ⎥
⎢
⎥
⎢⎣ 2 −5 1 10 ⎥⎦
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If you have MathType, see if you can duplicate the equations below. If you don’t have MathType, this would be a
good opportunity to download the evaluation version from the Design Science web site.
Other uses of MathType that go “beyond the basics”…

1. Systems of equations.
⎧ 3 x + 4 y + z = 17
⎪
⎨ 2 x + 3 y + 2 z = 15
⎪ x+ y+ = 4
⎩

⎧5x − 3 y = 6
⎨
⎩2 x + 7 y = 2

=3
⎧ x
⎪
=3
⎨2 x + y
⎪ 3x + 2 y + z = 3
⎩

⎧x = 3
⎪
⎨2 x + y = 3
⎪3 x + 2 y + z = 3
⎩

2. Dimensional analysis.
1 min
30 mi 5280 ft 1 h
⋅
⋅
⋅
1 mi 60 min 60 sec
h
= 44 ft sec

V=

or

1 min
30 mi 5280 ft 1 h
⋅
⋅
⋅
1 mi 60 min 60 sec
h
= 44 ft sec

V=

3. Step-by-step examples with comments.

T f = Tr + (T0 − Tr ) e

− rt

T f = 160; Tr = 68°; T0 = 212°; and r = 0.21

160 = 68 + ( 212 − 68 ) e−0.21t
92 = 144e −.021t
92
= e−0.21t
212
ln 92 − ln144 = −0.21t

Isolate the exponential expression.
Take the natural logarithm of both sides.

ln 92 − ln144
=t
−0.21
t = 2.13345106

Calculation - ready form

This is a good use
of User 1 and
User 2 styles and
sizes (MathType
only). This lets
you use your
normal font &
size for the
problem &
solution, and a
separate font &
size for the
notes.

4. Equations for Web pages.
5. Animated graphics for PowerPoint presentations or Web pages.
6. Chemistry notation.
Ba(NO3 ) 2 (aq) + 2 NH 4 IO3 (aq) → Ba(IO3 ) 2 (s) + 2 NH 4 NO3 (aq)
Solution

Solution

Pr ecipitate

Solution

Atomic
orbitals
2p

2s

↑↓

↑↓ ↑↓ ↑
ii

:F i
ii

1s

+

iH

2p

2s

↓ ⎯⎯
→ ↑↓

Bonding
orbital

↑↓ ↑↓

↑↓

ii

:F  H
ii
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What else can I do with MathType that I can’t do with Equation
Editor?
1. MathType includes over 200 symbols and templates that are not included in Equation Editor. Some
of these are shown here. (Many of these are currently available only in the Windows version.)
Examples:
∼ ≈
†
@ ≯
In addition, MathType includes the ability to include a tilde, hat, arc, or harpoon (vector barb) over
more than one character. It also includes cross-out templates for showing cancellation.
Examples: ABC inches
2. Color. MathType lets you color all or part of an equation, or use multiple colors in a single
equation. This is great for making captivating PowerPoint presentations or for printing color
transparencies on an ink jet printer. Example:
1 5 2 1 5
2
5
7
= ⋅ +
=
+
=
Find the LCD: +
x 2x 2 x 2x 2 x 2 x 2x
Denominators in red.

3. Web publishing. MathType lets you save your equations as GIFs to use in your web documents.
MathType can also generate MathML – an XML application that is the W3C standard for
publishing mathematics on the web, and makes math “accessible” to those with sight impairments
or learning disabilities.
4. Equation numbering. Not everyone needs to number equations or include references to equations in
the text of a document. If you are a textbook author or write manuscripts for journal publication,
you will appreciate the fact that MathType can number and reference your equations automatically
when used with Microsoft Word.
2 6
5. Precise formatting ruler. You get a sophisticated word processor-like ruler for
3 12 ⋅ 22 = 3 42
precise formatting. Align columns at operators, decimal points, or set tab stops to
make formatting easier and to give your documents a more professional look. This
− 34
− 34
example cannot be duplicated exactly in Equation Editor for two reasons: cross-out
templates, and ruler formatting (fractions aligned at right edge with a right2 34
justified tab).

6. New spacing adjustments possible:
•

Radical “check mark” width adjustment:

2
2

2
2

2
2

•
•
•

Subscript and superscript horizontal gap: x x x
Slash and diagonal fraction gap: 1 2 12 1 2
Horizontal gap between fence templates (parentheses, brackets, braces, etc.) and their contents:
( x2 − 4) (x2 − 4) ( x2 − 4 )

•

Stroke thickness for box lines, strike-throughs, radical signs, etc:
1
2
1
2
1
2
⋅
⋅
⋅
2
2
2
2
2
2
2

2

2
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